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4 Provide information about the contact.  

5 Click Add. 

 
  

Note:  
 You cannot add contacts to your Company Address Book. 
 If you want to add multiple contacts, you can them all at once, instead of adding one contact 

at a time.  
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About the New/Edit Contact page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Contacts > Add Contact 
or [check box for contact] > Edit. 

What you can do here 

Enter information about a new or existing contact for your personal address book. 

Options on this page 

  

Use this option… To…

Full name Enter the contact's first and last name. 

Email address Enter the contact's email address. 

Language Set the language in which any email messages that you send to 
the contact using your WebEx service site appear. 

Available only if your WebEx service Web site can be displayed in 
two or more languages. 

Company Enter the company or organization for which the contact works. 

Job title Enter the contact's position in a company or organization. 

URL Enter the URL, or Web address, for the contact's company or 
organization. 

Phone number/Phone 
number for mobile 
device/Fax number 

Enter the contact's phone numbers. For each number, you can 
specify the following: 

Country Code Specify the number that you must dial if the contact resides in 
another country. To select a different country code, click the link to 
display the display the Country Code window. From the drop-
down list, select the country in which the contact resides. 

Area or city code Enter the area or city code for the contact's phone number. 

Number Enter the phone number. 

Extension Enter the extension for the phone number, if any. 

Address 1 Enter the contact's street address. 

Address 2 Enter additional address information, if necessary. 
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Use this option… To…

State/Province Enter the contact's state or province. 

ZIP/Postal code Enter the contact's ZIP or postal code. 

Country Enter the country in which the contact resides. 

Username Enter the username with which the user logs in to your WebEx 
service Web site, if the contact has a user account. 

Notes Enter any additional information about the contact. 

 

 

Importing contact information in a file to your address book 
You can add information about multiple contacts simultaneously to your personal 
address book, by importing a comma-separated values (CSV) file. A CSV file has the 
.csv file extension; you can export information from many spreadsheet and email 
programs in CSV format. 

To create a CSV file: 

1 Open your address book. 

2 In the View drop-down list, ensure that Personal Address Book is selected. 

3 Click Export. 

4 Save the .csv file to your computer. 

5 Open the .csv file that you saved in a spreadsheet program, such as Microsoft 
Excel. 

6 Optional. If contact information exists in the file, you can delete it. 

7 Specify information about the new contacts in the .csv file. 
  

 Important: If you add a new contact, ensure that the UID field is blank.   

8 Save the .csv file. Ensure that you save it as a .csv file. 

To import a CSV file containing new contact information: 

1 Open your address book. 

2 In the View drop-down list, ensure that Personal Contacts is selected. 

3 In the Import From drop-down list, select Comma Delimited Files. 

4 Click Import. 
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5 Select the .csv file in which you added new contact information. 

6 Click Open. 

7 Click Upload File. 

The View Personal Contacts page appears, allowing you to review the contact 
information you are importing. 

8 Click Submit. 

A confirmation message appears. 

9 Click Yes. 
  

Note: If an error exists in any new or updated contact information, a message appears, informing 
you that no contact information was imported. 

 

About the Contact Information CSV template 

How to access this template 

On your WebEx service Web site, click My WebEx > My Contacts > View > 
Personal Address Book > Export. 

What you can do here 

Specify information about multiple contacts, which you can then import to your 
personal address book. 

Fields in this template 

  

Option Description

UUID A number that your WebEx service site creates to identify the contact. If 
you add a new contact to the CSV file, you must leave this field blank. 

Name Required. The contact's first and last name. 

Email Required. The contact's email address. The email address must be in 
the following format: 

name@company.com 

Company The company or organization for which the contact works. 

JobTitle The contact's position in a company or organization. 

URL The URL, or Web address, for the contact's company or organization. 
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Option Description

OffCntry The country code for the contact's office phone-that is, the number that 
you must dial if the contact resides in another country. 

OffArea The area or city code for the contact's office phone number. 

OffLoc The contact's office phone number. 

OffExt The extension for the contact's office phone number, if any. 

CellCntry The country code for the contact's cellular or mobile phone-that is, the 
number that you must dial if the contact resides in another country. 

CellArea The area or city code for the contact's cellular or mobile phone number. 

CellLoc The contact's cellular or mobile phone number. 

CellExt The extension for the contact's cellular or mobile phone number, if any. 

FaxCntry The country code for the contact's fax number-that is, the number that 
you must dial if the contact resides in another country. 

FaxArea The area or city code for the contact's fax number. 

FaxLoc The contact's fax number. 

FaxExt The extension for the contact's fax machine, if any. 

Address 1 The contact's street address. 

Address 2 The additional address information, if necessary. 

State/Province The contact's state or province. 

ZIP/Postal The contact's ZIP or postal code. 

Country The country in which the contact resides. 

Username The user name with which the user logs in to your WebEx service Web 
site, if the contact has a user account. 

Notes Any additional information about the contact. 

 

 

Importing contact information from Outlook to your address 
book 

If you use Microsoft Outlook, you can import the contacts that you maintain in your 
Microsoft Outlook address book or folder to your personal address book on your 
WebEx service Web site. 
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To import contacts from Outlook to your personal address book: 

1 Open your address book. 

2 In the View drop-down list, select Personal Contacts. 

3 In the Import from drop-down list, select Microsoft Outlook. 

4 Click Import. 

The Choose Profile dialog box appears. 

5 In the Profile Name drop-down list, select the Outlook user profile that includes 
the contact information that you want to import. 

6 Click OK. 
  

Note:  
 When you import contacts in Outlook, your WebEx service Web site retrieves contact 

information from the Outlook address book or folder in which you have chosen to keep 
personal addresses. For information about keeping personal addresses in Outlook, refer to 
Microsoft Outlook Help. 

 If your personal address book already includes a contact that is also in your Outlook contacts 
list, the contact is not imported. However, if you change the contact's email address in your 
personal address book, importing the contact from Outlook creates a new contact in your 
personal address book. 

 

Viewing and editing contact information in your address 
book 

In your personal address book, you can view and edit information about individual 
contacts in your Personal Contacts list. You can view, but not edit, information about 
contacts in your Company Address Book. 

To view or edit contact information: 

1 Open your address book. 

2 In the View drop-down list, select one of the following: 

 Personal Contacts 

 Company Address Book 

A list of contacts appears. 

3 Locate the contact whose information you want to view or edit. 

4 Under Name, select the contact whose information you want to view or edit. 

5 Do one of the following: 
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 If the contact is in your Personal Contacts list, click Edit. 

 If the contact is in your Company Address Book, click View Info. 

Information about the contact appears. 

6 Optional. If the contact is in your Personal Contacts list, edit the information that 
you want to change on the Edit Contact's Information page. 

7 Click OK. 
 

Finding a contact in your personal address book 
You can quickly locate a contact in your personal address book, using one of several 
methods. 

To search for a contact in your address book: 

1 Open your address book. 

2 In the View drop-down list, select a contacts list. 

3 Do any of the following: 

 In the Index, click a letter of the alphabet to display a list of contacts whose 
names begin with that letter. For example, the name Susan Jones appears 
under S. 

 To search for a contact in the list you are currently viewing, type text that 
appears in either the contact's name or email address in the Search for box, 
and then click Search. 

 If the entire list of contacts does not fit on a single page, view another page by 
clicking the links for the page numbers. 

 Sort your personal contacts or company address book by name, email address, 
or phone number by clicking the column headings. 

 

Creating a distribution list in your address book 
You can create distribution lists for your personal address book. A distribution list 
includes two or more contacts for which you provide a common name and appears in 
your Personal Contacts list. For example, you can create a distribution list named 
Sales Department, which includes contacts who are members of your Sales 
Department. If you want to invite members of the department to a training session, 
you can select the group rather than each member individually. 

To create a distribution list: 

1 Open your address book. 
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2 Click Add Distribution List. 

The Add Distribution List page appears. 
  

 

 

3 In the Name box, type the name of the group. 

4 Optional. In the Description box, type descriptive information about the group. 

5 Under Members, locate the contacts that you want to add to the distribution list, 
by doing any of the following: 

 Search for a contact, by typing all or part of the contact's first or last name in 
the Search box. 

 Click the letter that corresponds to the first letter of the contact's first name. 

 Click All to list all contacts in your Personal Contacts list. 

6 Optional. To add a new contact to your Personal Contacts list, under Members, 
click Add Contact. 

7 In the box on the left, select the contacts that you want to add to the distribution 
list. 

8 Click Add to move contacts you selected to the box on the right. 

9 After you finish adding contacts to the distribution list, click Add to create the 
list. 

In your Personal Contacts list, the Distribution List indicator appears to the left 
of the new distribution list: 
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Editing a distribution list in your address book 
You can add or remove contacts from any distribution list that you have created for 
your personal address book. You can also change a group's name or descriptive 
information. 

To edit a distribution list: 

1 Open your address book. 

2 In the View drop-down list, select Personal Contacts. 

A list of the contacts in your Personal Contacts list appears, including any 
distribution lists that you have created. The Distribution List indicator appears to 
the left of a distribution list: 

  

 
 

Under Name, select the name of the distribution list. The Edit Distribution List 
page appears. 
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3 Edit information about the distribution list.  

4 Click Update. 

 
 

About the Add/Edit Distribution List page 

How to access this page 

On your WebEx service Web site, click My WebEx > My Contacts > Add 
Distribution List. Or, select distribution list in Personal Contacts list. 

What you can do here 

Add contacts to your distribution list or remove contacts from your distribution list. 
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Options on this page 

  

Use this option… To…

Name Enter the name of the distribution list. For example, if you want to 
add a distribution list that includes members of your company's 
sales department, you might name the list Sales Department. 

Description Optionally enter descriptive information about the distribution list, 
to help you identify it later. 

Search Find a contact, by typing all or part of the contact's first or last 
name. 

Index Find a contact, by clicking the letter that corresponds to the first 
letter of the contact's first name. To list contacts for which you 
identified with a number, click #. To list all contacts in your 
Personal Contacts list, click All. 

Add> Add a one or more selected contacts to your distribution list. 

<Remove Remove one or more selected contacts from your distribution list. 

Add Contact Add a new contact to your Personal Contacts list and add the 
contact to your distribution list. 

Add Add a new distribution list to your Personal Contacts list. 

Update Update an existing distribution list that you have edited. 

 

 

Deleting contact information in your address book 
You can delete any contact or distribution lists that you have added to your personal 
address book. 

To delete a contact or contact group: 

1 Open your address book. 

2 In the View drop-down list, select Personal Contacts. 

3 In the list that appears, select the check box for the contact or distribution list that 
you want to delete. 

4 Click Delete. 

A message appears, asking you to confirm the deletion. 
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5 Click OK. 
 

Maintaining your user profile 
  

 

About maintaining your user profile 
Once you obtain a user account, you can edit your user profile at any time to do the 
following: 

 Maintain personal information, including your 

 Full name 

 Username (if your site administrator provides this option) 

 Password 

 Contact information (including your street address, email address, and phone 
numbers) 

 Tracking codes that your organization uses to keep records of your training 
sessions (such as project, department, and division numbers) 

 Specify whether to display links to your company's partner sites in the My WebEx 
navigation bar, if your site administrator set up partner links 

 Manage any scheduling templates that you saved 

 Set options for your Personal Training Session Room options, including the 
images and welcome message that appear on the page 

 Set default options for your online sessions, including 

 The default session type that you want to use, if your account includes 
multiple session types 

 Whether your scheduled training sessions are automatically removed from 
your list of training sessions once the training session ends 

 Whether the Quick Start page appears in the content viewer once you start a 
training session 

 The users who can schedule training sessions on your behalf 

 Set Web site preferences, including: 

 The home page that appears when you access your WebEx service Web site 

 The time zone in which training session times appear 



 Chapter 29: Using My WebEx 

 

 435 

 The language in which your Web site displays text, if your site includes 
multiple languages 

 The locale (the format in which your Web site displays dates, times, currency 
values, and numbers) 

 

About the My WebEx Profile page 

How to access this template 

On your WebEx service Web site, click My WebEx > My Profile. 

What you can do here 

Manage the following: 

 Account information 

 Personal information 

 Partner integration options 

 Scheduling templates (does not apply to Support Center) 

 Personal Meeting Room information 

 Training Session options 

 Web page preferences, including your home page and language 

 Support Center CSR Dashboard options (Support Center only) 

Personal Information options 

  

Use this option… To…

Username Specify the username for your account. You can change this 
name only if the administrator for your WebEx service Web site 
provides this option. 

Tip: If you need to change your username, but cannot edit it on 
this page, ask your site administrator to change your username 
or create a new account for you. 
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Use this option… To…

Change Password  Old password: Type the old password for your account. 

 New password: Specify the new password for your 
account. A password: 

 Must contain at least four characters 

 Can consist of a maximum of 32 characters 

 Can include any letters, numbers, or special 
characters, but not spaces 

 Is case sensitive 

 Retype New password: Verify that you typed your 
password correctly in the New password box. 

Call-in authentication If enabled by your site administrator, allows you to be 
authenticated and placed into the correct teleconference without 
needing to enter a meeting number whenever you dial into any 
CLI (caller line identification) or ANI (automatic number 
identification) enabled teleconference. Selecting this option for a 
phone number in your user profile maps your email address to 
that phone number. Caller authentication is available only if you 
have been invited to a CLI/ANI enabled teleconference by email 
during the meeting scheduling process. Caller authentication is 
not available if you are dialing in to a CLI/ANI enabled 
teleconference. 

Call-back When selected for a phone number in your user profile, allows 
you to receive a call from the teleconferencing service if it is 
using an integrated call-back feature. If your site includes the 
international call-back option, participants in other countries 
receive a call back. For more information about this option, ask 
your site administrator. 

PIN If enabled by your site administrator, allows you specify a call-in 
authentication PIN to prevent “spoofers” from using your 
number to dial into a teleconference. If your site administrator 
sets the authentication PIN as mandatory for all accounts using 
call-in authentication on your site, you must specify a PIN 
number or caller authentication will be disabled for your 
account. This option is available only if you have selected the 
Call-in authentication option for at least one of the phone 
numbers in your profile. The PIN can also be used to provide a 
secondary level of authentication for calls where the host is 
using the phone and may need to invite additional attendees. 

Other personal 
information options 

Enter any personal information that you want to maintain in your 
profile. 



 Chapter 29: Using My WebEx 

 

 437 

Partner integration options 

Your site administrator can set up custom links to the Web sites of your company's 
partners, and then display the links on the My WebEx navigation bar. For example, if 
your company uses another company's Web site to provide a service, your site 
administrator can provide a link to that company's site in your My WebEx navigation 
bar. You can then show or hide that link. 
  

Use this option.... To....

Display partner links in 
My WebEx 

Shows or hides partner site links in the My WebEx navigation 
bar. 

 
 

Scheduling template options  

Use these options to manage scheduling templates that you set up using the 
scheduling options on your site. 
  

Use this option… To…

Get Info Shows the settings you set for the selected template. 

Edit Opens the scheduling options on your site for the selected 
template. 

Delete Removes the selected template from your profile. 

Select All Selects all the scheduling templates, allowing you to delete 
them all at once. 

 
 

Calendar Work Hours options 

Use these options to specify working hours to use with scheduling calendars. 
  

Use this option… To…

Start time Select the start time for your daily work calendar. 

End time Select the end time for your daily work calendar. 
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Personal Meeting Room options 

  

Use this option… To…

Personal Meeting Room 
URL 

Go to your Personal Meeting Room page. You can click the 
URL from the My Profile page to preview your current Personal 
Meeting Room page. 

Your Personal Meeting Room page shows online sessions that 
you scheduled and any in-progress sessions that you are 
currently hosting. 

Users to whom you provide your personal URL can use this 
page to join any meeting that you are hosting. They can also 
download files in any folders that you share. 

Welcome Message Enter the message that appears on your Personal Meeting 
Room page. A message can be a maximum of 128 characters, 
including spaces and punctuation. 

To specify a message, type it in the box, and then click Update. 

Upload Image Upload an image file from your computer or another computer 
on your network to your Personal Meeting Room page. For 
example, you can upload a picture of yourself, your company's 
logo, or a picture of your company's product. Visitors to your 
page can see the image that you upload. 

The image can be an maximum of 160 pixels wide. If you 
upload a larger image, its width is automatically reduced to 160 
pixels. However, the image's aspect ratio is maintained. 

Browse: Lets you locate an image. 

Upload: Uploads the image that you selected. 

Current Image: Displays the image that currently appears on 
your Personal Meeting Room page. 

Delete: Removes the current image from your Personal 
Meeting Room page. This button is available only if you have 
uploaded an image for the page. 

Customize branding of 
header area 

Upload a banner image to the non-scrolling header area for 
your Personal Meeting Room page. For example, you can 
upload your company's logo or an advertisement. Visitors to 
your page can see the image that you upload. Available only if 
your site administrator has turned on this option for your 
account. 

The image can be an maximum of 75 pixels high. If you upload 
a larger image, its height is automatically reduced to 75 pixels. 
However, the image's aspect ratio is maintained. 

Browse: Lets you locate a banner image. 

Upload: Uploads the banner image that you selected. 

Current Image: Displays the banner image that currently 
appears on your Personal Meeting Room page. 
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Use this option… To…
Delete: Removes the current banner image from your Personal 
Meeting Room page. This button is available only if you have 
uploaded an image for the page. 

Productivity Tools Options 

  

Use this option.... To....

Automatically download 
Productivity Tools when 
logging in to the WebEx 
service site 

Specify that WebEx Productivity Tools should be downloaded 
automatically when you log in to the WebEx service site. If this 
option is turned off, you can still download Productivity Tools 
manually. 

 

 

Session Options 

  

Use this option… To…

Default session type Specify the default session type that you host, if your user 
account lets you host different types of online sessions. 

For more information about session types, ask the site 
administrator for your WebEx service. 

You can change this default setting when scheduling a meeting. 

 

Quick Start Specify whether the Quick Start page appears in the content 
viewer once you start a meeting. The Quick Start lets you start 
sharing activities quickly, as an alternative to starting them from 
a menu or toolbar. 

 Show Quick Start to host and presenter: The Quick Start 
appears in the content viewer for the host and presenter. 

 Show Quick Start to attendees: The Quick Start appears 
in the content viewer for attendees. Select this option only if 
you intend to let attendees share information during your 
meetings. 

You can change this default setting when scheduling a meeting. 
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Scheduling permission Type the email addresses for any users whom you want to let 
schedule meetings for you. Separate email addresses with 
either a comma or a semicolon. 

Select From Host List: Open the Select Host page, which 
contains a list of all users who have accounts on your WebEx 
service Web site. On this page, you can select users whom you 
want to let schedule meetings for you. 

 

 

Web page preferences options 

  

Use this option… To…

Home page Set the first page that appears when you access your WebEx service 
Web site. 

Time zone Set the time zone in which you reside. 

If you select a time zone for which daylight saving time (DST) is in 
effect, your WebEx service Web site automatically adjusts its clock for 
daylight saving time 

Note: The selected time zone appears: 

 Only on your view of your WebEx service Web site, not other 
users' views 

 In all meeting invitations that you send using your WebEx service 
Web site 

Language Set the language in which your WebEx service Web site displays text. 

Note: The languages that appear in this list are limited to the languages 
that have been set up for your Web site. 

Locale Set the format in which your Web site displays dates, times, currency 
values, and numbers. 

 

 

Editing your user profile 
Once you obtain a user account, you can edit your user profile at any time to change 
account login information, contact information, and other options available for your 
account. 
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To edit your user profile: 

1 Log in to your WebEx service Web site. 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

4 Edit the information on the page. 

5 When you are finished editing your user profile, click Update. 

 
 

Managing scheduling templates 
  

About managing scheduling templates 
Scheduling templates let you save the options you set for a training session for later 
use. Once you save a scheduling template, you can use it to quickly schedule another 
training session, instead of setting the same options again. If you saved a scheduling 
template using the Save As Template option when scheduling a training session, you 
can manage the template, as follows: 

 View the options you set in the template. 

 Edit the options you set in the template. 

 Delete the template. 
 

Managing scheduling templates 
You can view, edit, or delete any scheduling templates that you saved. 

To manage scheduling templates: 

1 Log in to your WebEx service Web site. 

2 On the navigation bar, click My WebEx. 

3 Click My Profile. 

The My Profile page appears. 

4 Under Scheduling Templates, select a template in the list. 

5 Click one of the following buttons to perform an action on the template: 

 Get Info: Shows the options you set in the template. 
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 Edit: Opens the scheduling options on your site. 

 Delete: Removes the template from your profile. 
 

Generating Reports 
  

 

About generating reports 
If your user account includes the reports option, you can view the following reports: 
  

 Note:   

  For some reports, if you click on the report link within 15 minutes after the training 
session ends, you will see a preliminary version of that report. The preliminary report 
provides quick access to data before the final, more accurate data is available. The 
preliminary report contains only a subset of the information that is available in the 
final report. 

 When the final, more accurate data is available, which is usually 24 hours after the 
training session ends, the preliminary report is replaced by the final report. 

 You can download both preliminary reports and final reports as comma-separated 
values (CSV) files. 

 

General Training Session Usage reports 

These reports contain information about each online session that you host. You can 
view the following reports: 

 Summary Usage report: Contains summary information about each training 
session including topic, date, start and end time, duration, number of attendees 
you invited, number of invited attendees who attended, and type of voice 
conference you used.  

  

 Note: Initially, this report appears as a Preliminary Usage Summary Report, but after the 
final, more accurate usage data is available, it is replaced by the Final Usage Summary 
Report. 

 

 Summary Usage report CSV (comma-separated values) file: Contains 
additional details about each training session, including the minutes that all 
participants were connected to the training session and tracking codes. 

 Session Detail report: Contains detailed information about each participant in a 
training session, including the time the participant joined and left the training 
session, the attentiveness during the training session, and any information that the 
attendee provided.  
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 Note: Initially, this report appears as a Preliminary Session Detail Report, but after the 
final, more accurate session detail data is available, it is replaced by the Final Session Detail 
Report. 

 

Access Anywhere usage report 

This report shows information about the computers that you access remotely, 
including the date and start and end times for each session. 

 

Training Center reports 

 These reports contain detailed information about the training sessions you host. 
You can view the following types of Training Center reports: 

 Live Training Usage report: The Live Training Usage report is available in two 
formats: 

 Live Training Usage Summary report: Contains a summary of the 
information about each training session, including the topic, date, start and 
end time, duration, number of attendees you invited, number of attendees who 
registered, and number of invited attendees who attended. 

  
 

 Note: Initially, this report appears as a Preliminary Live Training Usage Summary 
Report, but after the final, more accurate usage and attendance data is available, it is 
replaced by the Final Live Training Usage Summary Report. 

 

  

 Live Training Usage Detail report: Contains detailed information about 
each attendee in a training session, including the time the participant joined 
and left the meeting and any information that the attendee provided, such as 
registration information. You can also view information about any registrants 
who did not attend a session. 

 Recorded Training Access report: Contains access and registration information 
about each recorded training session that you published on your Training Center 
Web site. 

 Registration Report: Contains attendance, invitation, and registration 
information all of your live training sessions. 

 

 

Generating reports 
You can generate usage reports that provide information about each online training 
session that you have hosted on your site. 
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You can export or download the data to a comma-separated values (CSV) file which 
you can then open in a spreadsheet program such as Microsoft Excel. You can also 
print reports in a printer-friendly format. 

To generate a report: 

1 Log in to your WebEx service Web site, and then click My WebEx. 

2 Click My Reports. 

The My Reports page appears. 

3 Choose the type of report you want to generate. 

4 Specify your search criteria, such as a date range for which you want to view 
report data. 

5 Click Display Report. 

6 To change the order in which report data is sorted, click the column headings. 

The report data is sorted by the column that has an arrow next to the column 
heading. To reverse the sort order, click the column heading. To sort using 
another column, click that column's heading. 

7 Do one of the following, as appropriate: 

 If you are viewing a general training session usage report and want to display 
the report in a format that is suitable for printing, click Printer-Friendly 
Format. 

8 If you are viewing the usage report for an a training session and want to view the 
content in the report, click the link for the training session name. 

9 To export the report data in comma-separated values (CSV) format, click Export 
Report or Export. 

10 If available, click links on the report to display more details. 
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Chapter 31 

 

About publishing recorded training sessions 
If you or another user records a training session using WebEx Recorder, you can 
publish the recording on your Training Center Web site. Users on your site can either 
view or download the recording from the Recorded Sessions page, or from the 
Recording Information page if you have sent them a recording URL. 

You can publish a recording by: 

 Uploading it to your Training Center Web site. 

 Specify the Web address, or URL, at which the recording resides on another 
server. 

 Creating a presentation using the On-Demand Module, if your site includes that 
option 

When publishing a recording, you can: 

 Specify whether all users on your site can view or download the recording, or 
only users who have an account on your site 

 Password-protect the recording 

 Require that users register to view or download the recording 

Once you publish a recording, you can: 

 Edit information about it 

 Edit the recording, if your site has the On-Demand Module option 

 Stop publishing it 

Publishing a Recorded 
Training Session 
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Opening your list of recorded training sessions 
To publish, delete, or edit information about a recording, you must open your list of 
recorded training sessions. 

To open your list of recorded training sessions: 

1 Log in to your Training Center Web site. 

2 Do one of the following: 

 Click Host a Session > My Training Recordings. 

 Click My WebEx > My Files > My Training Recordings. 

The My Training Recordings page appears. 
  
 

 
 

Publishing a recorded training session 
You can publish a recorded training session that was created with WebEx Recorder. A 
recording that you publish must be in the WebEx Recording format (WRF), which has 
a .wrf extension. 

To publish a recording, you can do one of the following: 

 (Optional feature) Create a presentation using the On-Demand Module, with 
which you can re-create the live training experience, insert a test, or add narration. 
You can upload an existing recording file or PowerPoint file from your computer 
or another computer on your local network. 

  
 

 Note: The number of On-Demand presentations that can be stored on your Training Center 
Web site is determined by your licensing agreement. If the upload limit has been reached, 
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you will be unable to create a recording until one is removed. 
  

 Upload the recording to the server for your Training Center Web site. The file that 
you upload must reside on your computer or a local server. 

 Specify the Web address, or URL, for the recording on a publicly accessible Web 
server. Because your storage space for recordings on your site is limited, you can 
use this option to publish an unlimited number of recordings, or recordings with 
large file sizes. To use this option, you may need to ask your organization's 
Webmaster to store the recording on the server and provide you with its URL. 

To publish a recorded training session: 

1 Open the My Training Recordings page. 

2 Click Add a Recording. 

The Add a Recording page appears. 

3 In the Recording topic box, specify the topic of the recorded training. 

4 Under Type, select an option to specify whether the recording is listed on the 
Recorded Sessions page on your site and, if it is listed, which types of users can 
view the recording. 

5 Optional. If eCommerce is enabled for your Training Center Web site, enter the 
session fee and payment information. You must enable Registration in order to 
use this feature. 

 Session fee: Enter the amount you want to charge for the session. The default 
value is 0 (free). 

 Allow attendees to use coupons: Select this check box to allow attendees to 
use coupons when registering. 

 Access period: Specify how often an attendee can view the recording after 
registration is approved. 

6 In the Presenter box, specify the presenter's name. 

7 In the Email Address box, specify the presenter's email address. 

8 In the Description box, enter a description of the recorded training session. 

9 Optional: Specify the agenda for the training session. 

10 Under Recording File, publish the recording in one of the following ways: 

Specify the URL for the file on another server: 

a. Select I will provide a URL. 

b. Type the URL in the box. 
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Upload the recording from your local machine to your Training Center Web site: 

a. Select Use the file on my local machine. 

b. Click Browse, and then select the file that you want to publish. 

c. Click Upload file. 

 

Upload the recording from the network server: 

a. Select Find the recording from WebEx network. 

b. Click Look Up, and then select the file that you want to publish. 
  

11 (Optional feature) Create a presentation using the On-Demand Module. After 
selecting Create a Presentation Using Presentation Studio, you can create  one 
of the following presentations: 

  
 

 Note: Choosing this option will disable the duration, file size, date, and destination address 
fields. 

 

  

Specify a WebEx Recording file: 

a. Select WebEx Recording File (*.wrf). 

b. Click Browse, and then select the file that you want to publish. 
  
 Note: The maximum file size is 200 MB. Files that exceed the maximum will not be 

created, causing the Recording Creation Failed page to appear. 
 

c. Click Open. 

d. Select either Graphics or Text for playback quality optimization. 
  

Specify a PowerPoint presentation for which you will add narration via telephone: 

a. Select PowerPoint with audio narration using telephone. 

b. Click Browse to select the presentation's PowerPoint file. 

c. If you want to attach the PowerPoint file for presentation viewers to download 
it, select the Make this file available as an attachment check box. 

  

Specify a PowerPoint presentation for which you will add narration using a video 
or audio file: 
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a. Select PowerPoint with narration using video or audio File. 

b. Click Browse to select the presentation's PowerPoint file. 

c. If you want to attach the PowerPoint file for presentation viewers to download 
it, select the Make this file available as an attachment check box. 

d. Select whether you want to upload a video or audio file from the File type 
drop-down list. This file should be prepared in advance. 

e. Click Browse to select the video or audio file. 

f. In the Width and Height boxes, specify the size, in pixels, of the video screen 
in the audio/video window of the Presentation Player. 

  
 

 Note: The width must be between 192 to 360 pixels, and the height must be between 144 
and 240 pixels. 

 

  

Specify a video-only or audio-only presentation: 

a. Select Video or audio only. 

b. Select whether you want to upload a video or audio file from the File type 
drop-down list. This file should be prepared in advance. 

c. Click Browse to select the video or audio file. 
  

12 If you did not use the On-Demand Module: 

a. Specify the duration, file size, and date for the recording. 

b. Optional: Specify a destination URL—that is, a Web page that appears 
automatically once a visitor finishes viewing a recording. 

13 Optional: Specify file access options. 

These settings protect your recording by requiring user authentication to view or 
download, and are necessary if eCommerce is enabled. 

14 Click Add. 

If you used the On-Demand Module, the Recording Created page opens. 
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15 Click OK. 

You will receive an email confirmation that the presentation has been successfully 
uploaded and converted into a Presentation Studio presentation. The email will 
include a link that will take you to the My Training Recordings page. 

  

Making a recording available to users 
Training Center automatically generates a URL for each recorded training session or 
On-Demand Module recorded session that you create. This URL appears on the 
Recording Information page. 
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You can make the recording available to users in the following ways: 

 Send the URL via email 

 Copy the URL to another location, such as an instant message or to a Web site 
  
 

Note: If you have set a password, registration, or eCommerce for your recording, these features 
will be enabled when the user accesses the recording from the URL. 
  

To make the recording available via email: 

1 On the Recording Information page, in the URL section, click the email link. 

Your email tool opens, with the recording URL in the body of the email. 
  
 

 

 
  

2 Enter the recipient's email address and send the email. 

To copy the recording URL to another location: 

1 On the Recording Information page, in the URL section, highlight the URL with 
your cursor. 

2 Right-click the URL and select Copy. 

3 Do one of the following: 

 Paste the URL into an instant message and send it to users. 

 Add the URL to another Web site where users can access the recording. 
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Editing information about a recorded training session 
Once you publish a recorded training session, you can edit information about the 
recording at any time. This information appears on the Recording Information page 
that users can view if they select a recording to view or download on the Recorded 
Sessions page. 
  
 

Note: If your site has the On-Demand Module option, and the recording contains a Presentation 
Studio presentation, you can edit information about the recording only in the On-Demand Module 
(Presentation Studio) editor. 
  

To edit information about a recorded training session: 

1 Open the My Training Recordings page. 

2 In your list of recordings, click Modify for the recording for which you want to 
edit information. 

If your site does not include the Presentation Studio option, the Edit Recording 
Information page appears. 

3 Specify new information about the recording. 

4 Click Save. 

If your site includes the On-Demand Module option, the On-Demand Module 
(Presentation Studio) editor opens to the Edit Properties page. 

5 Specify new information about the recording. 

6 Click Submit Changes. 

The Recording Updated page opens. 
  
 

 

 
  

7 Click OK. 
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You will receive an email confirmation that the presentation has been successfully 
republished. 

  

Editing a recorded training presentation 
If you publish a recorded training presentation that you created using the On-Demand 
Module, you can edit the recording at any time. 

To edit a recorded training session: 

1 Open the My Training Recordings page. 

2 In your list of recordings, click Modify for the recording for which you want to 
edit information. 

The On-Demand Module (Presentation Studio) editor opens. 
  
 

 

 
  

You can edit the presentation by clicking one of the four links at the top of the 
page: 

 Edit Properties: Edit the training recording information. 

 Customize Presentation: (Optional) Customize the Presentation Player by 
adding your own logo or presenter image. 
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 Slide Detail: Display slide title and start time, as well as display a larger 
image of the file. 

 Edit Slides: Modify your presentation by: 

 Changing the title of a slide 

 Rearranging the slide order 

 Deleting a slide 

 Inserting a file. 

 Inserting a URL. 

 Inserting a test. 

 Inserting a Presentation Studio presentation. 

3 Click Submit Changes when you have completed your edits. 

The Recording Updated page opens. 
  
 

 

 
  

4 Click OK. 

You will receive an email confirmation that the presentation has been successfully 
republished. 

  

Adding a file to your presentation 

You can insert a slide from a file located on your computer. 

To insert a file into your presentation: 

1 In the On-Demand Module (Presentation Studio) editor, click Edit Slides. 
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2 Under Current Presentation, highlight the slide next to which you want to insert 
the file. 

3 Under Source, ensure that Insert a file is selected. 

4 From the drop-down list, select the appropriate insert option for the file, relative 
to your highlighted slide. 

5 Click Insert. 

6 In the Insert a File page, enter a title for the new slide that will contain the file. 

7 Click Browse to insert the file from your computer. 

8 Select the file and click Open. 

9 Select the check box if you want to pause the Media Player at this slide during 
playback. 

10 Click Insert. 

11 Click Close to return to the Edit Slides page. 
 

Adding a URL to your presentation 

You can insert a slide that contains a URL. When this page is reached in the 
presentation, a separate window opens up at this Web address. 
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To insert a URL into your presentation: 

1 In the On-Demand Module (Presentation Studio) editor, click Edit Slides. 

2 Under Current Presentation, highlight the slide next to which you want to insert 
the URL. 

3 Under Source, select Insert a URL. 

4 From the drop-down list, select the appropriate insert option for the URL, relative 
to your highlighted slide. 

5 Click Insert. 

6 In the Insert a URL page, enter a title for the new slide that will contain the URL. 

7 Enter the URL and click Insert. 

8 Select the check box if you want to pause the Media Player at this URL slide 
during playback. 

9 Click Close to return to the Edit Slides page. 
 

Adding a test to your recording 

To test users of a recorded training session, you must add tests to the training 
recording that they will be using. 

Before you can add a test to a recording, the test must already exist in the Test 
Library. Tests cannot be created or edited in the On-Demand Module (Presentation 
Studio) editor. 

 

To insert a test into your presentation: 

1 In the On-Demand Module (Presentation Studio) editor, click Edit Slides. 

2 Under Current Presentation, highlight the slide next to which you want to insert 
the test. 

3 Under Source, select Insert a test. 

4 From the drop-down list, select the appropriate insert option for the URL, relative 
to your highlighted slide. 

5 Click Insert. 

The Add a Test page opens in a new window. 
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6 Select a test and click Next. 

7 In the Test Delivery Options page that appears, select the appropriate options and 
click Save. 

8 Click Close to return to the Edit Slides page. 
 

Adding PowerPoint slides from your desktop 

If your Training Center site includes the On-Demand Module option, you can insert 
slides from an existing PowerPoint presentation on your desktop. 

To add PowerPoint slides from your desktop: 

1 In the On-Demand Module (Presentation Studio) editor, click Edit Slides. 

2 Under Current Presentation, highlight the slide next to which you want to insert 
the PowerPoint slides. 

3 Under Source, select Insert PowerPoint slides from desktop. 

4 From the drop-down list, select the appropriate insert option for the PowerPoint 
slides, relative to your highlighted slide. 

5 Click Insert. 

6 In the Insert slides page, click Browse to select the PowerPoint file to insert. 

7 Click Insert. 

8 Click Close to return to the Edit Slides page. 
 

Adding slides from a Presentation Studio presentation 

If your Training Center site includes the On-Demand Module option, you can insert a 
slide from one of your existing Presentation Studio presentations. 
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To add slides from another presentation: 

1 In the On-Demand Module (Presentation Studio) editor, click Edit Slides. 

2 Under Current Presentation, highlight a slide near the point in which you want to 
insert a new slide from an existing presentation. 

3 Under Source, click Select an online presentation. 

The My Presentations page opens in a new window. 
  
 

 

 
  

4 Click Select to select the presentation from which you want to insert a slide into 
your current presentation. 

5 Highlight the slide that you want to insert. 

6 Click Replace slide only to replace the highlighted slide in the current 
presentation with the highlighted slide in the source presentation. 

7 Click Insert before or Insert after to insert the Source highlighted slide into the 
Current Presentation relative to its highlighted slide. 

 

Adding narration to your presentation 

You can use your phone to record audio narration for your presentation slides. Your 
viewers will hear your narration when they view your presentation. 
  
 

Note: You can add narration only to a PowerPoint presentation that has been successfully 
converted to a Presentation Studio presentation. Upon successful conversion, you will receive 
narration instructions by email. 
  

To add narration to your presentation from the Recording Information page: 

1 Open the My Training Recordings page. 

2 In your list of recordings, click the Topic for the recording for which you want to 
add narration. 
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3 From the Recording Information page, click Narrate. 

4 Follow the instructions listed on the Record an Audio Narration page. 
 

Removing a recorded training session from your site 
You can either: 

 Temporarily remove the recording from the Recorded Sessions page on your site 
but keep it in your list of recordings on your My Training Recordings page 

 Permanently remove the recording from both the Recorded Sessions page on your 
site and your My Training Recordings page 

(For sites without the On-Demand Module) To temporarily remove a published 
recorded training session from the Recorded Sessions page: 

1 Open the My Training Recordings page. 

2 In your list of recordings, select Modify from the drop-down list for the recording 
for which you want to edit information. 

3 Under Type, select Private. 

4 Click Save. 

(For sites with the On-Demand Module) To temporarily remove a published 
recorded training session from the Recorded Sessions page: 

1 Open the My Training Recordings page. 

2 In your list of recordings, select Modify from the drop-down list for the recording 
for which you want to edit information. 

The On-Demand Module (Presentation Studio) editor opens to the Edit Properties 
page. 

3 Select Private. 

4 Click Submit Changes. 

The Recording Updated page opens. 

5 Click OK. 

To permanently remove a published recorded training session: 

1 Open the My Training Recordings page. 

2 In your list of recordings, select Delete from the drop-down list for the recording 
that you want to delete. 

A confirmation message appears. 
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3 Click OK. 
 

Viewing the Recorded Training Access Detail Report 
The Recorded Training Access Detail Report contains access information about 
recorded training sessions on your Training Center Web site. This report includes the 
following information for each time that your recorded training session is viewed: 

 viewer's name and email address 

 registration information 

 download information 

 access time and date 

 for WebEx presentations created with the On-Demand Module, the duration that 
the recording was viewed 

To view the Recorded Training Access Detail Report: 

1 Log in to your Training Center Web site, and then click My WebEx. 

2 Click My Reports. 

The My WebEx Reports page appears. 

3 Click Recorded Training Access Report. 

The Recorded Training Access Report page appears. 
  
 

 

 
  

4 Specify your search criteria, such as a date range, topic, and sorting preferences, 
and click Display Report. 

The Recorded Training Access Summary Report page appears, which includes 
information on all the recorded training sessions that have been viewed. 
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5 Click the Topic for the recorded training session report that you wish to view. 

The Recorded Training Access Detail Report page appears. 
  
 

 

 
  

6 If you wish to print the results, click Printer-friendly format. 

7 If you wish to save the report as a comma-separated values (CSV) file, which you 
can export into a spreadsheet program, click Export Report. 

 

About the My Training Recordings page 

How to access this page 

On your Training Center Web site, do one of the following: 

 Click Host a Session > My Training Recordings. 

 Click My WebEx > My Files > My Training Recordings. 
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What you can do here 

You can use the My Training Recordings page to archive and publish recordings of 
training sessions that you host. You can record training sessions using WebEx 
Recorder, which is available in the Session window during a training session. 

Options on this tab 

  
 

Option Description

Topic 
Indicates the topic for the recording. Once you publish a recording, you can 
click this link to view information about the recording and access a page on 
which you can change information about the recording. 

Presenter Indicates the name of the person who presented information that was 
recorded. By default, your name appears as the presenter. 

Type 

Indicates the publication status of the recorded training session, which can be 
one of the following: 

 Private: The recorded session is not published; that is, the recorded 
session does not appear on the Recorded Sessions page on your 
Training Center Web site. 

 Public: The recorded session is published; that is, the recorded session 
appears on the Recorded Sessions page on your Training Center Web 
site. 

Internal: The recorded session is published, but only users who have an 
account on your Training Center Web site can view the recording on the 
Recorded Sessions page on your Training Center Web site. 

Date Indicates the date that the recording was created. 

Size Indicates the size of the recorded file, in kilobytes. 

Duration Indicates the duration of the recording. 

Format 
Indicates the format of the recorded file. The recording may include a 
PowerPoint file (PPT), a network-based recording file (ARF), or an On-
Demand Module file (Presentation Studio). 

 Click this icon to play the recording. 

 Click this icon to send the recording via email. 

 Click this icon to reveal the Download, Modify, and Delete options. 

 Click this icon to download the recording to a local drive. 

 Click this icon to change any information about the recording that appears in 
this list. 
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Option Description
 

 Click this icon to delete the selected recording file from the list. 

 

If this icon appears, indicates that registration is required; that is, users must 
provide information on a registration form to view the recording. You can 
specify the information that you want users to provide by editing the 
recording's information. 

 If this icon appears, indicates that the recording is password protected; that is, 
users must provide the password that you specify to view the recording. 

 If this icon appears, indicates that the recording file is currently uploading. 

Add a Recording 

Opens the Add a Recording page, on which you can publish a recording by 
doing one of the following: 

 Specify the URL for the file on another server 

 Upload the recording from your local machine to your Training Center 
Web site 

 Upload the recording from the network server 

 Create a Presentation Studio presentation, if your site has the On-
Demand Module option. 

Once you add a recording, it appears in the list. 

 

 

 

About the Add a Recording/Edit Recording Information page 

How to access this page 

On your Training Center Web site, do one of the following: 

 Click Host a Session > My Training Recordings > Add a Recording or Edit 
icon. 

 Click My WebEx > My Files > My Training Recordings > Add a Recording 
or Edit icon. 

Options on this page 
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Option Description

(This information appears on the Edit Properties page if you have the On-Demand Module.) 

Recording topic Specifies the topic for the recording. (Required with the On-Demand 
Module) 

Type 

Specifies to whom the recording is available. 

 Private: The recording is not published on the Recorded Sessions 
page on your Training Center Web site. It appears only on your My 
Training Recordings page. 

 Listed for all (public): Publishes the recording on the Recorded 
Sessions page on your Training Center Web site. Visitors to your 
site need not log in to your site to see the recording in the list. 

 Listed for authorized users only (internal): Publishes the 
recording on the Recorded Sessions page on your Training Center 
Web site. Users must log in to your site to see the recording in the 
list. 

Session Fee and 
Payment 

(Optional feature) Set up eCommerce if you want to charge attendees for 
viewing the recording: 

 Enter the session fee 

 Select whether you want to allow viewers to use coupons. 

 Set the access period. 

Note Registration must be enabled in order to use eCommerce. 

Presenter Specifies the name of the presenter for the training session or the person 
who made the recording. (Required with the On-Demand Module) 

Email Address Specifies the presenter's email address. (Required with the On-Demand 
Module) 

Description Specifies a description of the recorded training session. (Required with 
the On-Demand Module) 

Agenda Specifies the agenda for the recorded session. 

Recording file 

Lets you select a recording file to publish. 

 I will provide a URL: Specifies that the recording file resides on a 
server on the Internet. Specify the URL for a recording file in the 
box. The server on which the file resides must be publicly 
accessible—that is, the server cannot be behind a firewall on your 
private network. If you use this option, your Training Center Web 
site creates a link to the file on the Recorded Sessions page. 

 Use the file on my local machine: Specifies that the recording file 
resides on your computer or another computer on your local 
network. 

 Browse: Lets you select a recording file that resides on your 
computer or another local computer on your network. 
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Option Description
 Upload file: Uploads the file specified in the Browse box to 

your Training Center Web site. 

 Find the recording from WebEx network: Specifies that the 
recording file resides on your WebEx network server. 

 Look Up: Lets you select a file from a list of recordings that 
resides on your WebEx network server. 

 See the "Playback Control Options" section later in this section 
for information on recording playback options. 

 (Optional feature) Create a Presentation Using Presentation 
Studio: Specifies that you want to create a presentation using the 
On-Demand Module. There are four options: 

 WebEx Recording File (.wrf) - create a presentation based on a 
recorded training session 

 PowerPoint with audio narration using telephone - create a 
voice narrated presentation based on a PowerPoint 
presentation 

 PowerPoint with narration using video or audio File - create a 
Web-based presentation with streaming video or audio based 
on a PowerPoint presentation 

 Video or audio only - create a standalone Web-based 
presentation with streaming video or audio. No PowerPoint 
presentation is necessary. 

Note If you choose the Create a Presentation Using Presentation 
Studio option, the Duration, File size, and Date fields will be disabled. 

Duration 

(Sites without the On-
Demand Module) 

Specifies the length of time for the recording. 

File size 

(Sites without the On-
Demand Module) 

Specifies the size of the recording file, in kilobytes (KB). 

Date 

(Sites without the On-
Demand Module) 

Specifies the date on which the recording was made. 

Set password Specifies the password to view or download the recording. 

Confirm password Specifies the password again, to prevent typing errors. 

Registration 

 Requires registration: Specifies that a user must provide 
information on a registration form before viewing or downloading the 
recording. 

 Customize form: Opens a page on which you can specify the 
information that a user must specify on the registration form. 
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Option Description

Add View/Download 

 Attendees can view recordings: Users can view the recording on 
your Training Center Web site, but they cannot download the 
recording file to their computers. 

 Attendees can view and download recordings: Users can view 
the recording on your Training Center Web site, and they can 
download the recording file to their computers. 

Note The Attendees can view and download recordings option is 
disabled for Presentation Studio recordings. 

Display this URL at 
end of playback 

(Sites without the On-
Demand Module) 

Specifies a Web page that automatically appears once the recording 
ends. 

Add 

(Sites without the On-
Demand Module) 

Adds the new recording to your list of recordings. If you published the 
recording, it appears on the Recorded Sessions page on your Training 
Center Web site. 

Add 

(Sites with the On-
Demand Module) 

Opens the Recording Created page, which shows that your recording 
has been created successfully. Clicking OK adds the new recording to 
your list of recordings. If you published the recording, it appears on the 
Recorded Sessions page on your Training Center Web site. 

Save 

(Sites without the On-
Demand Module) 

Saves your changes to the information about the recording. 

Save 

(Sites with the On-
Demand Module) 

Opens the Recording Updated page, which shows that your recording 
has been updated successfully. Clicking OK saves your changes to the 
information about the recording. 

Submit Changes 

(Sites without the On-
Demand Module) 

Opens the Recording Updated page, which shows that your recording 
has been updated successfully. Clicking OK saves your changes and 
opens the Recording Information page. 

Cancel 

(Sites without the On-
Demand Module) 

Cancels all changes made on the page and returns you to the My 
Training Recordings page. 

Customize Presentation page (On-Demand Module only) 

Select a logo image 
for the presentation 
(optional) 

Click Browse to select a JPEG or GIF file that resides on your computer. 
The file size should be less than 60 KB (210W x 40H pixels is 
recommended). 

Select a presenter 
image (optional) 

Click Browse to select a JPEG file that resides on your computer. The 
file size should be less than 60 KB (192W x 144H pixels is 
recommended). If there is no presenter image, the first PowerPoint slide 
will appear. 
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Option Description

Submit Changes 
Opens the Recording Updated page, which shows that your recording 
has been updated successfully. Clicking OK saves your changes and 
opens the Recording Information page. 

Cancel Cancels all changes made on the page and returns you to the My 
Training Recordings page. 

Slide Detail page (On-Demand Module only) 

Thumbnail/Zoom 
Click the slide thumbnail or Zoom to view a larger image of the slide. If 
the slide contains a file, URL, or test, it will open in a separate window 
for viewing. 

Listen to Audio Click Listen to Audio to open the associated audio file in a new window.

Submit Changes 
Opens the Recording Updated page, which shows that your recording 
has been updated successfully. Clicking OK saves your changes and 
opens the Recording Information page. 

Cancel Cancels all changes made on the page and returns you to the My 
Training Recordings page. 

Edit Slides page (On-Demand Module only) 

Source 

 insert before/insert after: Inserts the file, URL, or test before or 
after the highlighted slide in the current presentation.  

 Insert a file: Opens a window where you can name and insert a 
new slide into the presentation from a file stored on your computer.  

 Insert a URL: Opens a window where you can name and insert a 
new slide into the presentation that contains a URL.  

 Insert a test: Opens the Add a Test page, where you can select a 
test from the Test Library and add it to the presentation.  

 Insert PowerPoint slides from desktop: Select Insert to add 
PowerPoint slides from your desktop into your presentation.  

 Insert slides from an online presentation: Click Select an online 
presentation to open a window where you select one of your 
Presentation Studio presentations, the slides of which will appear in 
the Select slide section.  

 Replace slide only: Replaces the highlighted slide in the 
current presentation with the highlighted slide in the source 
presentation.  

 Insert before/after: Inserts the highlighted slide into the current 
presentation according to insert settings and the selected 
location.  

 Zoom: Opens a larger image of the slide. 

Current Presentation 
 Modify slide title: Opens a window where you can change the title 

of the highlighted slide. 

 Delete: Removes the highlighted slide from the presentation 
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Option Description
 Zoom: Opens a larger image of the slide. 

Submit Changes 
Opens the Recording Updated page, which shows that your recording 
has been updated successfully. Clicking OK saves your changes and 
opens the Recording Information page. 

Cancel Cancels all changes made on the page and returns you to the My 
Training Recordings page. 

  

Playback control options 

  
 

Option Description

Panel Display Options Determines which panels are displayed in the recording when it 
is played back. You can select any of the following panels to be 
included the recording playback: 

 Chat 

 Q & A 

 Video 

 Polling 

 Notes 

 File Transfer 

 Participants 

 Table of Contents 

Panel display options do not modify the panel display in the 
actual recording that is stored on the WebEx network. 
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Option Description

Recording Playback 
Range 

Determines how much of the recording is actually played back. 
You can select either of the following: 

 Full playback: Plays back the full length of the recording. 
This option is selected by default. 

 Partial playback: Plays back only part of the recording 
based on your settings for the following options: 

 Start: X min X sec of the recording: Specifies the 
time to start playback; for example, you can use this 
option if you would like to omit the "dead time" at the 
beginning of the recording, or if you would like to show 
only a portion of the recording. 

 End: X min X sec of the recording: Specifies the 
time to end playback; for example, you can use this 
option if you would like to omit the "dead time" at the 
end of the recording. You can not specify an end time 
greater than the length of the actual recording. 

The partial playback range you specify does not modify the 
actual recording that is stored on the server. 

Include NBR player 
controls 

Includes full Network Recording Player controls, such as stop, 
pause, resume, fast forward, and rewind. This option is selected 
by default. If you would like to prevent viewers from skipping 
portions of the recording, you can turn off this option to omit 
Network Recording Player controls from the playback. 

 

 

About the On-Demand Module 
The On-Demand Module gives you the maximum flexibility to create high-impact, 
multimedia on-demand training content and publish it online for your attendees. You 
can use the On-Demand Module to: 

 Re-create the live training experience for on-demand access by inserting a 
recording of a live session. 

 Insert a test, and request your audience to take the test when they view the 
recording or presentation. 

 Create and deliver high-impact multimedia presentations complete with narration. 
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To create a presentation, select Create a Presentation Using Presentation Studio 
and specify one of the following files to upload (50 MB maximum): 

 an existing WebEx recording file (WRF) 

 a PowerPoint file (PPT) 

Once you complete the Add a Recording page, your presentation will be submitted for 
processing. Once it is ready, you will receive an email explaining how to edit the 
presentation or add narration (PowerPoint only). By editing the presentation, you can 
also insert a test for your attendees to take when they view the presentation. 

 

About Optimizing Recording Playback Quality 
Once you specify a .wrf file to upload when creating a presentation using the On-
Demand Module, you will be prompted to select which content to optimize. 

Options on this page 

  
 

Option Description

Graphics Select if the content of your presentation is graphic intensive. This option 
will provide better graphics quality during the playback of your recording. 

Text Select if the content of your presentation is text intensive. This option will 
provide better text quality during the playback of your recording. 

  
 

Note: This playback quality option cannot be edited. 
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Chapter 32 

About viewing a recorded training session 
If a training session host publishes a recorded training session on your Training 
Center Web site, you can view the recording. A host may require that you do one or 
both of the following to view a recorded training session: 

 Enroll to view a recorded training session. In this case, you must provide your 
name, email address, and any other information that the host requires. 

 Provide a password. In this case, you must obtain the password from the host. 

To view a recorded training session, you must use either the WebEx Player or the 
Windows Media Player 9 (or higher) to view it, depending on how the training 
session was recorded. 

Your Training Center Web site automatically downloads WebEx Player to your 
computer the first time you view a recorded training session. A WebEx Player is 
available for the Windows operating system. If you have a user account, you can also 
download WebEx Player for Windows from the Support page on your Training 
Center Web site. 

If the recording contains a Presentation Studio presentation, you will need the 
Windows Media Player 9 (or higher) on your computer to view it, as well as the 
following: 

 Windows 2000, XP, or Vista 

 Internet Explorer 6 or 7 (recommended), Firefox 3.0 or later, or Chrome 

 Flash Player 7 (recommended but not required if recording includes Flash 
content) 

Viewing a Recorded Training 
Session 



Chapter 31: Viewing a Recorded Training Session 

 

472 

 Sound card with proper driver installed 
 

Viewing a recorded training session 
You can view a recorded training session by streaming it from your Training Center 
Web site, or by clicking the recording URL link that the host has sent to you. Once 
you select a recording to view, your Training Center Web site automatically 
downloads WebEx Player to your computer, and then plays the recording. If the 
recording contains a Presentation Studio presentation, you will need the Windows 
Media Player 9 (or higher) to view it. 

To view a recorded training session: 

1 If the host requires that you have a user account to view a recording, log in to your 
Training Center Web site. 

2 On the navigation bar, expand Attend a Session. 

3 Click Recorded Sessions. 

The Recorded Sessions page appears. 

4 For the recording that you would like to view, click the Playback icon. 
  

  

 If viewing the recording requires a password or access code, enter the 
password or access code that the host gave to you, and then click OK. 

 If viewing the recording requires registration, provide the required 
information on the registration form that appears, and then click Register. 

 If viewing the recording requires payment information, provide the required 
information and any coupon codes on the registration form that appears, and 
then click Register. 

The WebEx Player or Presentation Studio Viewer opens and begins playing the 
recording. 

To access a recording URL from an email, instant message, or another Web 
site: 

1 Click the recording URL link that was provided by the host. 

The Recording Information page appears. 
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2 Click View. 

 If viewing the recording requires a password or access code, enter the 
password or access code that the host gave to you, and then click OK. 

 If viewing the recording requires registration, provide the required 
information on the registration form that appears, and then click Register. 

 If viewing the recording requires payment information, provide the required 
information and any coupon codes on the registration form that appears, and 
then click Register. 

The WebEx Player or Presentation Studio Viewer opens and begins playing the 
recording. 

3 Optional. To download the recording, click the Download icon and save the file 
to your computer. 

  

  
 




